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The Lake Michigan shore in northern Sheboygan County consists of steep bluffs
approximately 50 feet in height. Long term recession rates of approximately two feet per
year have been recorded along this segment of the shore. Storms and high water levels in
the Great Lakes accelerate shoreline erosion and bluff erosion and increase flooding and
property damages. During 1985-86, Lake Michigan set new record marks for high water
levels in the 20th century, leading to unprecedented property damage. Recently, water
levels in the Great Lakes have increased to a level that begins to concern the U.S Army
Corps of Engineers.
In order to discourage development in erosion hazard areas, preserve shore cover and
natural beauty and meet other public objectives, Sheboygan adopted a ShorelandFloodplain Ordinance on October 27, 1970. The ordinance regulates development within
1000 feet of the ordinary high water mark of navigable lakes, ponds, flowages, and
specified wetlands; 300 feet of navigable waterways; and within the 500 year floodplain.
Geographic information systems (GIS) may be utilized to more effectively manage
development in the coastal zone. This GIS application assesses coastal erosion impacts
and explores management issues related to shoreland development in the Town of Mosel
in northern Sheboygan County.
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General Instructions
These instructions are divided into seven sections. They are designed to be followed
from front to back (i.e. Section One first, then Section Two, etc.). Earlier sections
contain descriptions of basic ArcView 3.x operations. They also create themes that will
be used in the later sections.
As you move through the application, you may need to refer back to earlier descriptions
for performing a particular function. The Table of Contents is designed to help you move
back and forth through the document.
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1. Inputting and viewing existing databases.
In this section, you will input and view five data sources -- floodplains, parcel boundaries,
township zoning, a planimetric map and an orthophoto.

Create a project and a view.
From the ArcView File menu, choose New Project. Click the New
button. An empty view screen may appear entitled View 1. If not, select
the View icon and click New.
The ArcView project window and the View window can be enlarged by
using the maximize button in the upper right corner of the window or by
grabbing the corners of the window with the mouse.

From the View menu, choose Properties to display the View Properties
dialog box. Highlight the name View 1 and type in “Data Layers” as the
new name for this view. Set the Map Units to feet (the data are in the
Sheboygan County Coordinate System). Click OK.
Throughout this application, names will be provided for views, themes,
files, etc.. You may choose to use other names. However, references to
suggested file names will be made in later sections of the application so
it will work best if you use the names provided.

With the project window active, from the File menu, choose Save Project
As....
Like other windows-based programs, when a window is active in
ArcView, the title bar will be blue. If multiple windows are opened,
clicking on a window will make it the active window. Depending on
the type of active window (e.g. view, project, table, etc.), different
menu items and different buttons will appear at the top of the window.
If you have trouble finding an open window, look in the Window menu
option. At the bottom of the drop-down menu, you will see a list of
open windows in your project.

Locate the directory where you wish to save your data. In the file Name
input box, type a name for your project (8 characters or less). Click OK.
An ArcView project file is assigned the extension “.apr”. A project can
contain multiple views, map layouts and attribute tables. For this
Shoreland Zoning Applications model, all our work will be saved under
a single project. You may wish to adjust this according to your data
storage needs.
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Save your work frequently (select Save Project under any of the File menu)! If the
ArcView program crashes, you can lose any changes made since your last save. If
ArcView does crash and the project was recently saved, it will be very easy to recreate
where you left off by simply opening the project.

Add data files to view.
Click the Add Theme button to add data files as
themes into your view. In the dialog box, for Data
Source Type, choose Feature Data Source. Locate and highlight the
following files and click OK: mosflood.shp, mospar.shp, mosplan.shp
and moszone.shp. To add the digital orthophoto for the northern section
of the township, click the Add Theme button; this time choose Image
Data Source. Add the file called “moseldoq.tif.”
To rename the themes, click on a theme name to make it active. When a
theme is active, it is surrounded by a “raised” square in the Table of
Contents. From the Theme menu, choose Properties. In the Theme
Properties dialog box, make sure the Definition symbol is chosen
(outlined by a box). Highlight the current theme name, type a new name
and click OK. Rename the themes:
“mosplan.shp” to “Planimetric Map”
“mosflood.shp” to “Floodplains”
“moszone.shp” to “Town Zoning”
“moseldoq.tif” to “Orthophoto”
“mospar.shp” to “Mosel Parcels”
Click on the box in front of each theme to make the themes visible on the
screen.
Themes are drawn based on the order they appear in the Table of
Contents. In order to view a theme, you may need to move it above
another theme. To do this, click on the name of the theme to make it
active and drag it to a new site on the Table of Contents.
The Zoom to Active Theme(s) button can be used to zoom the view to
Mosel Township (make sure one of the Township themes is active).
You can also use the Zoom In button to focus on a smaller section of
the view. Use the Zoom to Full Extent button to view all the data of
all the themes.

Zoom to Active Theme(s)

Zoom In

Zoom to Full Extent

To display the Town Zoning theme by zoning codes, double click on the
theme to bring up the Legend Editor (Figure 1). Under Legend Type,
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choose Unique Value. For Values Field, choose Zoning. To change how
each of these categories are labeled in the view, highlight the current Label
description and change:
“A-1” to “Prime Agricultural”
“A-2” to “General Agricultural”
“B-1” to “Business”
“C-1” to “Conservancy”
“I-1” to “Industrial”
“R-1” to “Single Family Residence”
“R-2” to “Two Family Residence”
“R-3” to “Multiple Family Residence”
Click Apply in the Legend Editor to apply your changes to the view.
Close the Legend Editor.

Figure 1. Legend Editor
If you wish to read longer label names, you may need to widen the
Table of Contents display window.

Save your project.
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2. Modifying existing themes.
In this section, you will create new data layers (parcels, transportation, hydrography,
buildings, cemeteries and the bluff edge) by extracting information from existing themes.

Create new themes from the Planimetric Map.
The Planimetric Map theme has a data field called “lgds_level”. The codes in this field
distinguish line segments in the map according to their feature type. To display these
individual features, you will need to query the associated database (attribute table) for
specific criteria. This information can be stored in a query format or it can be used to
create a new theme in the ArcView shapefile format.
A shapefile is an ArcView format for storing geometric and attribute information on a
feature. When data in other spatial formats are converted into shapefiles, they maintain
the extent and units from the original format. When a new shapefile is created, the extent
and units of the new features are determined by existing themes within the view.
Although a shapefile has geometric references, it does not have topology. Therefore,
there may be limitations when using shapefiles or exporting them into another GIS
software program.
To create a theme with information on roads and
railroads, make the Planimetric Map theme active.
From the Theme menu, choose Properties. Click the Query button to
bring up the Query Builder dialog box (Figure 2).
From the Fields list, double-click lgds_level; this now appears in the
expression box. Next, you want to set this equal to a value (click once on
the ‘=‘ sign). From the Values list, double click ‘1’. Click once on the
‘or’ button to continue building the query. Return to the Fields list and
repeat the procedure for the values ‘2’,’3’,’4’ and ‘20’. Your finished
query should look like this: ([lgds_level] = 1) or ([lgds_level] = 2) or
([lgds_level] = 3) or ([lgds_ level] = 4 or ([lgds_level] = 20). Click OK
in the Query Builder and Theme Properties Dialogue Boxes. Your view
will now display only the transportation features of the Planimetric Map.
To convert this into a new theme, in the Theme menu, chose Convert to
Shapefile.... Choose a directory and name the file “mostrans.shp.” Click
OK. Answer Yes to add this shapefile to the view. Change the theme
name to “Transportation Routes.”
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Figure 2. Query Builder
You now have two themes which appear to have the same information.
However, the Planimetric Map theme still contains all its original
information but, because of the query, is displaying only a portion of
these features. To clear this query, highlight the Planimetric theme,
then in the Theme Properties Dialog Box, click Clear followed by OK.

To create a theme with information on buildings, build the following query
on the Planimetric Map theme: ([lgds_level] = 6) or ([lgds_level] = 8) or
([lgds-level] = 60). Create a shapefile, save the file as “mosbldg.shp,” add
it to your view and rename it “Buildings.”
To create a theme with information on water bodies, make sure the last
query is cleared then build the following query on the Planimetric Map
theme: ([lgds_level] = 12) or ([lgds_level] = 13). Create a shapefile, save
it as “moshydro.shp,” add it to your view and rename it “Hydrography.”
To create a theme with information on cemetery locations, build the
following query on the Planimetric Map theme: ([lgds_level] = 15) or
([lgds_level] = 27). Create a shapefile, save it as “moscult.shp,” add it to
your view and rename it “Cemeteries.”
Remember to clear the Planimetric Map theme’s query.

Modify the parcel map to create unique parcel identification numbers.
You will now extract a separate theme for mapping parcel ownership in the Township.
The new theme will be used for the rest of this application.
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The file “mospar” contains the digital parcel map for the Town of Mosel. If you look at
the individual records, you will find that some parcels (i.e. polygons) have identical
parcel identification numbers. Using this database will cause problems in subsequent
analysis, particularly when you try and link the database to other files. The best remedy
for this situation would be to assign unique parcel identification numbers to each parcel.
However, this is the job of the county records-keeper and not the GIS analyst. Another
solution is to merge parcels with identical parcel ids and create a separate theme. By
doing this, you can now use the spatial attributes of the parcel file in combination with
non-spatial attributes (e.g. owners name) found in other files. The down side of this
solution is that some information will be missing in your new file. Specifically, if two
identically-numbered parcels are adjacent to each other, the line separating the parcels
will disappear. In addition, two parcels that share identification numbers but are not
adjacent will combine into one, non-contiguous feature.
Make the Mospar.shp or Mosel Parcels theme active. Click
the Open Theme Table button to access the attribute data
for the Mospar.shp theme. Click on the name of the field “parcel_id”; it is
now selected and highlighted in grey.
To merge records based on the selected field, click
the Summarize button.
Save the file as
“parcels.dbf.” Shape should be the selected field and it should be
summarized by Merge. Click Add. Now change the Field to Area,
Summarize by Sum, and click Add. Click OK. In other words, you have
merged parcels with the same identification number and calculated the
area of any new parcels equal to the sum of its component parcel areas.
Add the theme to the Data Layers view and rename it “Parcels.”
When a theme is first created, it is displayed in a single color. With the Color Palette,
you can modify how the theme is displayed. For this view, you will want to display only
the outlines of the parcel theme. By making the non-outline portions transparent, you will
be able to view other themes under this data layer.
Open the Parcel theme’s Legend Editor, by clicking on the
Legend Editor icon. Double click on the symbol box; the
Fill Palette is now displayed.
Click the Color Palette button to change to the
Color Palette (Figure 3). Select Outline in the
Color box and click on your preferred choice from the colors displayed.
Now, choose Foreground for Color and click on the first box (with the
“x” through it). This indicates a clear foreground. Click Apply. Close
the Legend Editor and the Color Palette.
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If you have trouble getting the Foreground Color to change to
transparent, try doing this process in two steps. In other words, choose
an Outline Color then double click again on the symbol box and choose
the Foreground Color.

Figure 3. Color Palette
You may wish to remove the Mosel Parcel (Mospar.shp) theme from your
view. To do this, make this theme active. From the Edit menu, choose
Delete Themes. This command removes the themes from your view but
does not delete saved files from your directory. Click Yes to confirm these
deletions.
Save your project.
Close this view’s window. Under the File command, click close. If there
are any attribute table windows open, close these as well.
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3. Creating a map of the jurisdiction of the
Shoreland Zoning Ordinance.
In this section, you will create areas of shoreland zoning jurisdiction along lakes
and rivers. A map of this information will be produced. You will also learn how
to access a help file containing the text from the Ordinance document.

Create a new view.
From the Windows menu, open your project window by highlighting the
name of your file, denoted by the .apr extension. Create a new view called
“Shoreland Zoning Ordinance.” Set the Map Units to feet. You can copy a
theme between views, preserving the colors and other properties from the
original theme. In the Data Layers view, make the Parcels and the
Hydrography themes active.
In order to make multiple themes active, simply hold down the shift key
and select each theme. All selected themes should be surrounded by a
raised box.

Select Copy Themes from the Edit menu. Now, in the Shoreland Zoning
Ordinance View, choose Paste from the Edit menu.
Make the Hydrography theme the only active and visible theme. In the
Legend Editor, set the Legend Type to Unique Value and the Values Field
to lgds_level. Two values will be displayed. Label the value “12” as
“Lakes and Ponds.” Label the value “13” as “Rivers and Streams.”

Add a field describing shoreland zoning jurisdiction distances.
Based on the Shoreland-Floodplain Ordinance, zoning jurisdiction for navigable waters is
determined by the feature type (Lakes and Ponds = 1000 feet, Rivers and Streams = 300
feet).
Click the Open Theme Table button to access the attribute data for the
Hydrography theme. Choose Start Editing from the Table menu. From
the Edit menu, select Add Field. Name your field “Distance.” This will
be a number field; you can adjust the size of the field under Width and
Decimal Places. In this case, keep the default settings and click OK.
Choose Query from the Table menu. Construct the query:
([lgds_level] = 12). Click on New Set. Data satisfying this
query will now be highlighted yellow in the attribute table. Close the query
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window. With the Distance field selected (highlighted in gray), press the
Calculate button. In the expression box at the bottom left corner, type
“1000” and Click OK.
Clear the selection by clicking the Select None button.
Construct the next query: ([lgds_level] = 13) and give
these data the Distance value “300.” Clear the selection and choose Stop
Editing from the Table Menu.
Throughout these applications, you will be editing themes and tables.
Before making any changes, you will always need to make these
features ready for editing using the “start editing” function. If you find
yourself unable to start an operation (e.g. adding a field to a table),
check to make sure that “start editing” has been selected. “Stop
Editing” is equally important. Changes made to a theme must be saved,
and when you stop editing a feature, you will always be prompted to
indicate if you want to save these changes.

You are now going to access an ArcView program (referred to as an Avenue Script)
which is not part of the original software package. This particular script was
downloaded (free of charge) from the ESRI home page. You may wish to browse this
web site (http://www.esri.com) to locate other useful scripts developed by ESRI staff and
the ArcView user community.

Create shoreline jurisdiction zones using the buffering operation.
To create a shapefile illustrating this Distance
information, you need to add the Avenue buffer
script to your project. Return to your project window, select the Script
icon and click New. Under the Script menu, choose Load Text File....
Locate the file called “buffer3.ave” and click OK. The script should now
appear on your screen. You will need to compile the script by clicking the
Compile button. Close the file and under the Project menu, rename
“Script1” to “Theme.Buffer.”
You need to add the Theme.Buffer script as a button to your view. To do
this, select Customize under the Project window’s Project menu. In the
Customize dialog box (Figure 4), for Type select View, and for Category
choose Buttons. Scroll to the end of the button display and highlight the
Help button. Click Separator followed by New. Double-click on Click
and in the Script Manager dialog box, choose Theme.Buffer. Click OK.
Double-click Help, type “Runs Buffering Script” and click OK. Doubleclick on Icon, select B from the Icon Manager and click OK. Close the
Customize dialog box and return to your Shoreland Zoning Ordinance
view.
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Figure 4. Customize Box

You are now ready to run the buffer script. In the
view, make Hydrography the active theme. Click
the Theme.Buffer button. A series of dialog boxes will appear on your
screen. Name the file “buffers.shp.” Make sure Feature Buffer is
selected as the output display theme and click OK. Choose Buffer Item
as the buffer distance input. When asked to select the item containing
distance values, choose Distance. Line should be highlighted as the line
buffering scheme.
When running this buffer script, make sure you include the “.shp” extension when
choosing a name for your output file. If you get an error message regarding the
production of the output files try exiting the Avenue script and rerunning the buffer
operation, overwriting the previous shapefile.
When ArcView creates a buffer for a line segment, it locates the buffer a
specified distance on both sides of the line. On both ends of the line segment, it
forms a half circle which connects the two sides of the buffer. This half circle is
located the specified distance from the the line endpoints. If you create a buffer
from a multi-segmented line, you will see a series of circular buffers where the
line segments meet.
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To map the areas encompassed by the Shoreland Zoning Ordinance, you
will join the numerous polygons created by the buffering script. Make the
Buffers.shp theme active and click the Open Theme Table button.
Choose Start Editing from Table menu. In order to merge the polygons
based on a shared attribute, you will need to create a field with the same
value for all the polygons. Add a new field named “Zone” and calculate
all values for this field equal to “1”. Make sure the Zone field name is
selected and click the Summarize button. Name for your file “zone.dbf.”
Shape should be the selected field and it should be summarized by Merge.
Click Add then OK. Add the theme to the Shoreland Zoning Ordinance
view and rename it “Shoreland Zones.” Delete the Buffers.shp theme
from your view.

Create a map of the Shoreland Zoning Ordinance Jurisdiction.
Although you now have a display of this data on your computer screen, you will want to
use the Layout capabilities of ArcView for creating mapping products. These layouts can
contain views, tables, charts, scanned pictures and other graphic elements. They also can
contain legends, north arrows, scale bars and additional text.
Make the themes Hydrography, Parcels and Shoreland Zones visible.
Display them in the colors you wish for your map product. From the View
menu, choose Layout. In the Template Manager dialog box, select the
Portrait style and click OK. Your screen will now display the default
layout for this view. In the Layout menu, select Properties and rename
your layout “Shoreland Zoning Ordinance.”

If you maximize the Layout Window, you
will then need to click the Zoom to Page
button to fit the Layout Page to the Layout Window.

If you are happy with the default layout, you are now ready to export or
print. Check the page setup settings by selecting Page Setup... under the
Layout menu. Here you can set the orientation, size and resolution of the
output. If you wish to export the file, choose Export under the File menu.
An Export dialog box prompts you to choose the range of graphic export
options (under the List Files of Type drop-down menu). If you wish to
print the file, choose Print under the File menu. Printer setup options are
also available in the File menu.
You may wish to modify the default layout. The following instructions
highlight some of the graphic formatting options available.
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To select a feature for editing, click the Pointer button, then click the
feature. When a graphic is selected, it will be surrounded by an
invisible box bordered by four squares. It can now be resized using the
two-directional arrows or moved by simply dragging the box to the
desired location. You may need to move other graphics around to make
room for your selected graphic. To add a feature, click the Text button
for text or choose one of the items from the View Frame drop-down
menu. Now, click the mouse on the location where you wish to add the
graphic.

Pointer

Text

View Frame

Border: You can add a border around the layout to give the map a clean
look. To start, click and hold the Draw Tool. Drag the mouse down to
the Draw Rectangle Tool, then release. Position the crosshairs in the
upper left corner of the layout page, drag the cursor to define the box, then
release the mouse button. While the box is selected, choose Send to Back
from the Graphics menu. This will make it easier to select other graphic
elements to edit.
Draw Tool

Draw Rectangle Tool

Text: Under the Window menu, select Show
Symbol Palette... to access the Fill Palette. Click
the Font Palette button. This will allow you to make changes in text font
type, size and style. If you wish to modify the title to make it more
descriptive, double-click on the title text. This brings up the Text
Properties dialog box. Add “for Sheboygan County” to the title and click
OK. Resize the layout title to 24 pt and add a subheading “Enacted 1970.”
Scale Bar: Double-click on the scale bar to bring up the Scale Bar
Properties dialog box. Experiment with the selections to customize the
scale bar.
North Arrow: Double-click on the north arrow to bring up the North
Arrow Properties dialog box. Choose a new arrow type and change its
color using the Color Palette.
Close the layout.
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Access a hypertext help file of the Shoreland-Floodplain Ordinance
document.
Administering a zoning ordinance often requires reference to multiple maps and text
documents. Managing these documents in a paper form can become complicated.
ArcView, in concert with other software packages, can support creation of an “electronic
zoning ordinance” integrating both text and maps. A Windows help file was created for
the Sheboygan County Shoreland-Floodplain Ordinance using a software package called
RoboHelp from Blue Sky Software.
If you are using a computer operating system other than Windows (3.1, 95,
NT, 98, 2000, XP), skip this section. If you are using one of these three
systems, search for the Windows Help executable program for your
operating system. The name of this program varies; try “winhelp.exe” or
“winhlp32.exe”. Typically, you will find these files under the following
directories which vary by operating system:
Windows 3.1
winhelp.exe
\windows\system\
Windows 95
winhlp32.exe
\windows\
Windows XP
winhelp.exe
c:\windows\
-orwinhpl32.exe
c:\windows\system32
When you find this program, note its full pathway name.
From the Project window, highlight the Scripts icon and select New.
Type
System.Execute(“c:\windows\winhelp.exe
c:\coastgis\shebord.hlp”).
If necessary, substitute the appropriate
pathway in your system for the “c:\winnt\winhelp.exe” portion of the script
and substitute the appropriate pathway for the shebord.hlp file to where the
downloaded exercise data was stored. Click the Compile button. Rename
the script1 as “Ordinance.Help.”
Customize the project by adding this as a button to your view. Bring up
the customize window, located under the project window. In the
customize dialog box, choose View for Type and Buttons for Category.
Double Click Click and select the Ordinance.Help script. Add a button
after the icon added for the Theme.Buffer script (noted by the “B” icon).
Double click Icon and select Load. Under List Files of Type, choose
Windows Bitmap (*.bmp). Select the file “book.bmp” as the icon for
accessing the Ordinance. This icon will appear as a red book with a “Z”
(for zoning).
When the Ordinance is accessed through this Help system, the document
operates in a manner somewhat similar to a home page on the web.
Practice using the text links to move around the document.
Save your project.
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4. Evaluating potential Lake Michigan erosion
impacts.
In this section, you will identify potential impacts from the erosion of the Lake Michigan
coastline. Based on parameters outlined in the Shoreland-Floodplain Ordinance, you will
estimate the new location of the bluff edge as the current slope stabilizes (Part I). In
addition, using a 50-year time frame, you will project the future location of the shoreline
and bluff edge.
From these projections, land and buildings at risk will be identified
(Part II). In addition, economic impacts to land and building values will be estimated
(Part III). You will also examine potential impacts to nearby roads. The final analysis
will focus on sediment loss from erosion of the 50-foot bluff (Part IV).

Part I: Creating a map of the current stable slope, and
projections of future shoreline and bluff edge locations.
Extract a Lake Michigan shoreline theme.
All estimates of recession are based on the current location of the shoreline. This theme
will be extracted from the broader hydrography database.
Open the Shoreland Zoning Ordinance view. Make
the Hydrography theme visible and active. Click the
Select Feature button and then click on a section of the shoreline,
highlighting it in yellow. Holding down the shift key, continue clicking on
the shoreline until the entire shoreline is selected. Convert this selection to
a shapefile, save as “lakemich.shp,” add it to your view and rename it Lake
Michigan Shoreline.
Open a new view and copy the following themes from previous views:
Buildings, Transportation Routes, Orthophoto, Parcels and Lake Michigan
Shoreline. Name this view “Shoreline Recession Scenarios” and set the
map units to feet.

Create a map of the bluff edge as the current bluff erodes to a stable
angle.
The Ordinance defines a stable slope angle as 2.5 feet of horizontal distance for every one
foot of vertical distance. In this area of the County, the average bluff is 50 feet high.
Therefore, the location for the top edge of the bluff, based on a stable slope, will be 125
feet inland from the shoreline. You will use the buffer operation to create a 125-foot
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buffer from the shoreline. The inland line of the buffer is an estimation of the bluff edge
location based on the current shoreline.
Create a buffer around the Lake Michigan Shoreline theme named
“buff_125.shp.” Choose Feature Buffer, Buffer Distance, 125 and Line
in the appropriate dialog boxes.
Lets improve the look of this buffer by merging the multiple polygons into a single
polygon. Although this will not change functional operations involving the buffer themes
(e.g. overlays), it will produce clearer output products.
Merge these multiple polygons by summarizing on the Buff_dis field.
Save your file as “buf2_125.dbf” and add the file to your view.
Another way you can improve the look of your buffer is to clip off the portion of the
polygon that extends both 125 feet into Lake Michigan and out from the endpoints of the
shoreline line segment. You will do this with the help of a theme clipping script that will
clip a point, line or polygon theme to the size of another polygon theme.
Add the script “clip.ave” to your project, rename it as “ThemeClip” and
compile the script. Customize the view by adding a button, assigning it
the icon “C” and the Help description “Runs Clipping Script,” and
linking this button to the new script.
Click the Clip button. Choose buf2_125.shp as the
intersect theme and Parcels as the clipping theme.
In other words, the buffer will be clipped to the area where it overlaps with
the parcels data (i.e. the land). Save your file as “sta_bluf.shp.” Add the
theme to your view, rename it “Current Stable Bluff,” and display only the
outline of the buffer. Delete the buff_125.shp and buf2_125.shp from your
view.
Now, move the Lake Michigan Shoreline theme to the top of the Table of
Contents. The inland line of the buffer visually represents the bluff edge
estimation.
If you zoom in on the Orthophoto, in certain areas you will be able to discern the current
location of the bluff. Compare this with your estimation of the stable bluff location.
Because the stable slope angle will actually vary depending on the underlying geological
makeup of the slope, it is appropriate to think of the future bluff as falling somewhere
within a range of locations around the setback estimation.
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Create a map of the projected shoreline location after 50 years of
recession.
The setback distance described in the Shoreland-Floodplain Ordinance is based on a longterm shoreline recession rate of two feet per year for the northern half of Sheboygan
County. Because the Ordinance considers a 50-year period to be the “useful life of a
typical residence,” you will use this time interval as a basis for your analysis. In other
words, the location of the Lake Michigan shoreline in 50 years is projected to be 100 feet
inland from its current location. You will use the buffer operation to create a 100-foot
buffer from the shoreline. The inland line of the buffer is an estimation of the future
shoreline location.
Create a buffer around the Lake Michigan Shoreline theme named
“buff_100.shp.” Choose Feature Buffer, Buffer Distance, 100 and Line
in the appropriate dialog boxes. Merge these multiple polygons by
summarizing on the Buff_dis field. Save your file as “buf2_100.dbf.”
Clip this buffer to the Parcels theme, saving the file as “pred_shr.shp.”
Add the theme to your view and rename it “50-year Shoreline.” Delete the
buff_100.shp and buf2_100.shp files.

Create a map of the required setback from the Lake Michigan
shoreline.
The total setback in northern Sheboygan County is based on both the recession of the
shoreline and the stabilization of the slope. This distance totals 225 feet from the Lake
Michigan shore. In order to map the setback requirements, you will use the buffer
command to create a buffer from the current shoreline. The inland line of this buffer is
one way to estimate the location of the bluff edge in 50 years. It will also illustrate the
Lake Michigan setback requirements in the Ordinance.
With the Lake Michigan Shoreline theme active, click the Buffer button.
Save your file as "buff_225.shp." Select Feature Buffer, Buffer
Distance, 225 and Line in the appropriate dialog boxes. Use the
summarize function on the buffer to merge the polygons into one polygon
based on the shared value in the “buff_dis” field. Save this file as
“buf2_225.dbf.” Clip this buffer to the Shoreline Parcels theme, saving
the file as “LM_setbk.shp” and renaming the theme “Lake Michigan
Setback.” Clear the unmerged and unclipped buffers from your Table of
Contents. Visually examine the impact of shoreline recession on nearby
buildings and roads.
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Part II: Determining land and buildings at risk
Identify high risk land areas and buildings based on stabilization of the
slope at its current location.
Add the theme “age.shp” to your view. This theme was created by
locating a point on each parcel’s primary structure that is closest to the
Lake Michigan shoreline. Rename the theme “Shoreline Structures.”
There is room for improving the Buildings theme. The data for the Buildings theme is
classified into three categories: residential (from an aerial photo), agricultural and
buildings (surveyed). However, there are inaccuracies in the classifications for this data
set. In addition, the buildings could have been structured as polygons instead of multiple
line segments to make their display, coding and analysis more effective. A close look at
the features will illustrate the inconsistencies of the digitizing process. Because of these
problems, a new simplified theme (age.shp) was created for this application.
All land within this Current Stable Bluff theme is likely to become part of the bluff as it
stabilizes. You will now select all buildings within this area as “high risk” of being lost
to erosion processes.
With the Shoreline Structures theme active, under the Theme menu,
choose Select by Theme. Select features of active theme that Intersect
with the selected features of Current Stable Bluff. Click New Set.
Open the table for the Shoreline Structures theme and add a string field
called "Risk." One record should be highlighted for being at high risk.
With the Risk field highlighted, use the Calculate button to set this field
equal to “High” (make sure to include the quotation marks to identify this
as a string expression). Clear the selection on the Shoreline Structures
theme and save your edits.
You will use the Shoreline Structures theme to determine whether the buildings on a
parcel are impacted by bluff recession. You may recall that this point theme was created
by locating one point on the major building of each parcel that is closest to the lake. For
this analysis, you will assume that damage to this structure will result in the complete
loss of improvement values on the property. Obviously, this estimate does not account
for the value of other buildings on the property or partial damage to the primary
building. The database for this analysis could be improved by associating each building
with a separate value and by reformatting the building layer as polygons rather than line
segments.
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Identify moderate risk land areas and buildings found between the
current stable slope location and the Ordinance setback zone.
Over the next 50 years, the Ordinance estimates that all the land within the setback zone
will be lost to erosion from shoreline recession and bluff stabilization. Therefore, land
areas and buildings between the Current Stable Bluff and the Lake Michigan Setback
locations can be considered to be at “moderate risk” from the impacts of recession.
Ideally, a simple subtraction of the smaller buffer (Current Stable Bluff) from the larger
buffer (Lake Michigan Setback) could be used to create a new polygon identifying these
areas of moderate risk. However, ArcView 3.0 cannot perform this overlay operation
without writing a new Avenue script. Instead, you will rely on visual interpretation to
identify at-risk land areas and a query operation to identify at-risk buildings.
Visually examine the additional impacts to land from the estimated
shoreline recession over the next 50 years. Use the Select by Theme
operation to select all Shoreline Structures that intersect with the Lake
Michigan Setback theme. If you examine this table, you will note that you
have selected all the buildings within the buffer, including the one
previously identified at high risk.
With the Shoreline Structures table open, build the following query:
([risk] = “”). Choose Select From Set. In other words, you have
narrowed your selected building set to include only those buildings
without a value in the Risk field. Now, calculate the Risk field equal to
“Moderate”. Clear the selection on the Shoreline Structures theme and
save your edits.

Identify at-risk land areas and buildings within 50 feet of the setback.
One response to the threat of impacts from recession is to move the at-risk structures. In
order to move these buildings, land is needed on all sides of the structure for the
operation of moving equipment. It is estimated that at least 50 feet is needed on the side
of the building facing the lake for this undertaking. This translates to an additional 50
feet of at-risk land inside the setback zone.
With the Lake Michigan Shoreline theme active, create a 275-foot buffer
from this feature (buff_275.shp). Use the summarize function on the
buffer to merge the polygons into one polygon based on the shared value
in the “buff_dis” field. Save this file as “buf2_275.dbf.” Clip this buffer
to the Shoreline Parcels theme, saving the file as “at_risk.shp,” and
renaming the theme “Moving Area.” Delete the buff_275.shp and
buf2_275.shp files.
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Use the Select by Theme operation to select all Shoreline Structures that
intersect with the Moving Area. Build a query on this set to select only
those structures without a value in the Risk field. Now calculate the risk
field for this new set equal to “At Risk”. Clear the selection on the
Shoreline Structures theme and save the project.

Part III: Estimating the economic impact of recession.
Based on the location of the projected shoreline, you will estimate economic impacts to
assessed land values in the area. You will also estimate impacts to buildings and roads
from bluff edge recession. All these analyses will be based on the recession rate assumed
in the Shoreland-Floodplain Ordinance (i.e. two feet per year over a 50-year time frame).
For this analysis, you will be calculating the impact to lands based on the recession of
the shoreline. The actual amount of land lost depends on both the recession of the
shoreline cutting away the toe of the bluff, and the stabilization of the bluff causing
recession of the bluff edge. Therefore, the total land lost will likely fall somewhere
between the future shoreline location and the future bluff location.
Perhaps the best way to estimate this impact is to find the area between the current bluff
edge and the future stable bluff location for each parcel. This could be used to estimate
loss of land. However, without writing a new Avenue script, ArcView 3.0 cannot perform
these analyses. It cannot create a one-sided buffer (e.g. 100-feet inland from current
bluff edge) and cannot subtract one theme from another (e.g. current bluff edge from
future stable bluff location). Therefore, your analysis will focus on a simpler operation –
calculating the economic impacts to land lost from only recession of the shoreline.

Estimate the amount of land lost from shoreline recession.
Use the select by theme operation to select all parcels that are within 1000
feet of the shoreline. Save this theme as a shapefile by choosing Convert
to Shapefile under the Theme menu. Save this theme as par_shor.shp and
rename it “Shoreline Parcels.” You will be using this parcel theme for the
remainder of this section; delete the other Parcels theme from your view.
Add the Avenue Script “intrsect.ave” to your
project. Rename it “Theme.Intersect” and add it as
the button “I” to your view. This script creates a shapefile with polygons
formed wherever two themes overlap. These polygons contain the
attributes of both overlapping themes.
Begin by clicking the Intersect button. A series of question boxes will
appear. Choose Shoreline Parcels as the intersect theme and 50-year
Shoreline as the overlay theme. Save the file as “landlost.shp.”
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Now, calculate the area of these new intersect polygons by adding a
numeric field to the Attributes of Landlost table. Name this field
“Intersect Area.” (You may have to abbreviate the field name.) With the
new field selected, click the Calculate button and in the expression box,
type: [Shape].ReturnArea. This intersection area represents the amount
of land lost in each parcel to recession over a 50-year interval (based on a
recession rate equal to two feet per year).
Add a number field (2 decimal places) named “landlost” to the Attributes
of Landlost table. Calculate this field equal to Intersect Area /
Sum_Area. The landlost field estimates the proportion of land lost from
the total area of the parcel.

Estimate the value of the land lost to shoreline recession.
You are now going to match each parcel’s spatial information with data on the assessed
value of the land. If you examine the data on land values, you will see that several
records may share a common parcel identification number. This is because a parcel may
be assessed in more than one category and the information is stored as multiple records.
For this application, you will need to aggregate all multiple records so each parcel has
only one total assessed value.
Both spatial and attribute information on the parcels must be aggregated to perform the
analysis described in these GIS applications. In both cases, information is “lost” for
analytical purposes when the individual records are combined under one parcel
identification number. Clearly there is value in planning for GIS analysis functions when
defining and refining database management systems.
From the Project window, add the values63.txt table to you project. (Be
certain the file type is listed as .txt not .dbf.) Because ArcView cannot edit
a text file, you will need to export this file into a dBase format. Under the
File menu, select Export. Choose dBase as the export format and save
this file (values63.dbf). Add the dBase file to your project and open the
table.
Highlight the Parcel_id field; this is the field used to aggregate your data.
Click the Summarize Button. In the dialog box, choose a directory and
name for your file (valu_sum.dbf).Add the following three summary
fields, then click OK:
Field:
Acreage
Land_
Improv_

Summarize by:
Sum
Sum
Sum
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The new Valu_sum table will also be used to store data on the impact of
recession on shoreline parcel assessment value. Both the Landlost and
Valu_sum tables share common Parcel_id field values. With the join
operation, you will match and append records between tables through this
common identifier.
In performing the join operation, the Attributes of
Landlost table will be the source table, and
Value_sum will be your destination table. Make sure both tables are open.
Click the title bar of the Attributes of Landlost table to make it active.
Click on the Parcel_id field name in the this table. Now, click the title bar
of the Value_sum table to make it active and highlight the Parcel_id field.
Finally, click the Join button to execute the function. Examine the
additional fields in the Value_sum table.
When you execute a join, you are not affecting the physical files on the
disk. Rather, you are establishing a relationship between two tables.
When you save a project, you save the definition of this join in your
view. Therefore, next time you open the project, ArcView will
automatically rejoin the tables. When you want to make changes in
joined tables, you need to be in the “home” table for the particular
fields you wish to edit. Any changes you make will be reflected in the
destination table if you choose Refresh from the Table menu. You can
also make a permanent disk copy of a destination table by exporting this
table to a new file.

Add a number field called “lostvalu” to the Value_sum table and calculate
this field equal to landlost * Sum_Land_. In other words, the lostvalu
field contains the loss in assessed value for each shoreline parcel, based on
a recession rate of 2 feet per year over a 50 year period. Now, under the
Table menu, select Remove All Joins. Save edits.
This time with Valu_sum as the source table and Attributes of Shoreline
Parcels as the destination table, join the tables on Parcel_id. Examine the
data. Some of these parcels were not impacted by shoreline recession and
therefore show no loss of land value. In addition, remember that two of
the parcels are actually road right-of-way polygons and therefore have no
assessed values.
To summarize the total economic impacts to land values for the Town of
Mosel, narrow down your dataset to examine only those parcels financially
impacted by shoreline recession. Build a query on the joined Shoreline
Parcels theme. Select for all parcels where lostvalu > 0.
Note that two parcels adjacent to the coast are not selected. These parcels have no
matches in the tax assessment database and may point out an error in that database.

7/17/2003

Coastal GIS Applications -- Town of Mosel (ArcView 3.x)

Page 27

You may want to create a table to store information about the total impacts
of shoreline recession. In the project window, choose New for Tables and
pick a directory and name for your new table (lostvalu.dbf). An empty
table should appear on your screen, ready for editing. Add the following
fields:
Type
Width
Name
Recession Rate
String
30
Original Value
Number
12
Lost Value
Number
12
From the Edit menu, choose Add Record to add a blank record
To find the values for the Original Value field, you will need to make the
Attributes of Shoreline Parcels table active (a subset of this table should be
selected). With the Sum_Land_ field highlighted, under the Field menu,
choose Statistics. A box will appear with summary statistics for the
Sum_Land_ field. You are interested in the total value of the land for the
selected set; this is the Sum. Note this value. Now find the total value for
the lostvalu field.
Once again, make the lostvalu.dbf table active and
ready for editing. Click the Edit button; the cursor
should now appear as a hand with a pointing finger. Type the sum of the
Sum_Land_ values in the Original Value column and the sum of the
lostvalu values in the Lost Value column. Save your edits.

Estimate impacts to buildings from bluff edge recession.
Bluff recession will impact buildings before shoreline recession. Therefore, the estimated
50-year bluff edge location, as projected from the Ordinance setback requirements, will
be used for this analysis.
Make the Shoreline Structures, Buildings, Lake Michigan Setback and
Lake Michigan Shoreline themes visible.
In order to obtain totals for improvement values (original and losses), you
will need to join the Valu_sum.dbf (source table) and the table for the
Shoreline Structures theme (destination table) on Parcel_id. For the
Original Values, use the statistics operation to calculate the total value
(sum) of the Sum_Improv field for these records.
Now you will determine which buildings are impacted from recession of
the bluff. With the Shoreline Structures theme active, in the Shoreline
Recession view, use the select by theme operation to select all points that
intersect with the Lake Michigan Setback theme. Open the attribute table
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for the Shoreline Structures theme. The selected set will be highlighted;
note the sum statistics for Sum_Improv field.

Estimate the impacts to roads from bluff edge recession.
As with the buildings, recession of the bluff edge is a better predictor of impacts to roads
than shoreline recession.
Make the Transportation Routes, Lake Michigan Shoreline and Lake
Michigan Setback visible. Note how close the road (County LS) is to the
current bluff edge. You will be using the intersect operation to estimate
the length of road impacted by the bluff recession.
With the Transportation Routes theme active, select Properties. Build a
query, selecting only records with lgds_level = 2. This narrows the theme
down to just road centerlines, therefore preventing multiple counting of
impacts to the same road section.
Click the Intersect button and choose Transportation Routes for the
intersect theme and Lake Michigan Setback for the overlay theme.
Choose a directory and name for your file (lostroad.shp) and add the theme
to the Shoreline Recession Scenarios view. Rename the theme “Road
Impacts”.
To find the total length of road impacted, open the attribute table for the
Road Impacts theme. Add a number field called “Impact Length.”
Calculate this field equal to: [Shape].ReturnLength (this calculates the
lengths of the new line segments). To estimate the total length of road
impacted by bluff recession, use the statistic function for a sum of the
Impact Length field.
Save your project.

Part IV: Estimating the volume of sediment lost to erosion.
Shoreline erosion also impacts water quality in Lake Michigan by adding tons of
sediment into the Lake. It is possible to estimate the volume of sediment that will be lost
to erosion based on the bluff height, the recession rate, the time frame under
consideration and the distance of shoreline under analysis. You will access the formula
for calculating sediment volume through ArcView’s hot link tool.
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Set up a hot link to the file containing the sediment loss formula.
Hot links provide a tool for linking a theme in your view with an external file. These
external files may contain text or images, or they may be used to access a customized
script file. You can even use this tool to move between other views, layouts, tables and
charts within your ArcView project. In this section, you will create a new theme that will
act as a link to an image file containing the formula for calculating sediment loss.
With the Lake Michigan Shoreline theme visible,
zoom to the full extent of your view. Create a new
point theme, saving the file as sediment.shp. Place a point somewhere
along the Lake Michigan shoreline, just offshore. Stop editing, save your
edits and rename the theme “Sediment Formula.” Open the legend editor
for this theme and click the Marker Palette button. Choose a new symbol
for this theme (e.g. 16-point star). Clicking on this symbol will access
your hot link to the sediment formula.
To create the hot link, open the table for the Sediment Formula theme.
Add a new string field named “hotlink,” 50 characters in width. Edit the
value in this field by typing the pathway name to the file called
“formula.gif.” For example, this may look like: c:\coastgis\formula.gif
Stop editing and save your edits.
Click the Theme Properties button to access the
theme properties dialog box for the Sediment
Formula theme (Figure 5). Select the Hot Link icon. Under Field,
choose hotlink. Under Predefined Action, choose Link to Image File.
The Script should be Link.ImageFile. Click OK.

Figure 5. Theme Properties Box
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Calculate the sediment loss from shoreline recession and bluff
stabilization.
With the Sediment Formula theme active, click the
Hot Link button. Your cursor will now appear as a
lightning bolt. Place the bottom of the lightning bolt in the center of your
Sediment Formula point and click the left mouse button. A window
should now appear in your view displaying the sediment formula image
file (Figure 6). Examine the formula for computing the sediment loss.
Four variables are necessary for calculating this value: height of the bluff (h), recession
rate (r), time frame under consideration (t) and length of area under analysis (l). For this
application, you will define these variables as: h = 50 feet, r = 2 feet/year and t = 50
years. The length will be equal to the shoreline length for the Township. You may also
wish to calculate the sediment loss per mile of shoreline. If you decide to apply this
formula to another geographical area, remember to adjust the bluff height and recession
rate values accordingly.
Open the table for the Lake Michigan Shoreline theme. Calculate the total
length of the shoreline by finding the sum statistics for the length field.
Note this value for your sediment loss formula. Calculate the sediment
loss value based on the stable slope described by the Ordinance setback
distance. You may wish to convert these values from cubic feet into cubic
yards (divide by 27). Save your project.

Loss = (( r * t * h ) - ( 1.25 * h )) * l
where:

h = bluff height
r = recession rate
t = time frame under consideration
l = length of shoreline under analysis
If the future stable bluff is located further inland than the
future bluff, use the formula:
Loss = (( r * t * h ) + ( 1.25*h*h )) * l

Figure 6. Sediment Loss Formula
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5. Identifying parcels which may be difficult to
develop.
In this section, you will identify vacant parcels along the Lake Michigan shoreline which
may be difficult to develop under current zoning regulations.

Create buffer themes based on setback distances.
In this area of Sheboygan County, the setback requirements for all “Principle Buildings”
(e.g. homes, commercial buildings) along the Lake Michigan Shoreline is 225 feet from
the high water mark of Lake Michigan and 75 feet from any navigable inland waters (with
certain exceptions). In addition, Town of Mosel zoning requirements include an 80-foot
setback from road centerlines.
Return to your Shoreland Zoning Ordinance view. For this section, you
will focus on the required setbacks within the zones, rather than on the
zones themselves. You already have a theme illustrating the required
Setback from Lake Michigan. Copy this theme from your Shoreline
Recession Scenarios view. Also copy the Transportation Routes and
Buildings themes from the Data Layers view.
With the Hydrography theme active, create a buffer which illustrates a
setback zone of 75 feet for all inland waters. Save the file as “iw.shp” and
choose Feature Buffer, Buffer Distance, 75 and Line for the buffering
scheme. Merge the buffers into one polygon (summarize on the field
“Buff_dis”) and save this as “iw_sb.dbf.” When the theme is added to
your view, rename it “Inland Waters Setback.”
Now, make the Transportation Routes theme active. You will need to
narrow down this theme to show only road centerlines. Under the Theme
Properties menu, select Query. Build the following query: ({lgds_level}
= 1) and click OK. Now, buffer this selected set with an 80-foot buffer
distance. Save the file as “rd.shp.” Merge the buffers into one polygon as
“rd_sb.shp” and rename the theme “Road Setback.”
Finally, you are going to create a theme with all
three of these setbacks merged into a single zone
representing undevelopable lands. To do this, you will need to add a new
Avenue Script. Under the Script menu, select Load Text File..., and
choose the file “mrgthems.ave.” Compile the script and rename it
“Theme.Merge.” Customize your view window by adding this script as a
button with an “M”.
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Click your new Merge button. A series of question boxes will ask you
which themes you wish to merge. Highlight Road Setback, and click
OK. Repeat this procedure for Lake Michigan Setback and Inland
Waters Setback. Click Cancel to end the selection of themes. Save your
file as “nobd.shp.” Add the theme to the Shoreland Zoning Ordinance
view.
If you examine the attributes of this merge theme, you will note that each
of the buffers is a separate record (therefore, a separate feature). By
creating a field with a shared value and using the summarize operation,
now merge the three buffers into a single theme. Save this file as
“nobuild.dbf.” Bring the new file into the view and rename it
“Undevelopable Lands.”
You may want to clear themes from your view. For example, you will no
longer need to access any of the original buffers (all should end in .shp) so
these can be removed from your view.

Calculate the amount of developable land for each parcel.
In order to narrow down this analysis, you will now select vacant parcels along Lake
Michigan. In order to select only vacant parcels, you will first select parcels with
buildings and then reverse this selection.
Make the Parcels theme active and display it with a
gray foreground and with colored outlines. Choose
Select By Theme... in the Theme menu to create a new set by selecting
parcels that intersect with buildings. Now, reverse this set to highlight
vacant parcels by opening the parcels theme table and clicking the Switch
Selection button.
Close the table and, with the Parcels theme active, do another Select By
Theme.... Select features of Lake Michigan Shoreline. Highlight Are
Within Distance Of in the top box and type 1000 for the selection
distance. Click Select from Set to chose only from the previously selected
vacant parcels.
At this point, you can visually examine the impacts of the
various setback zones on vacant property. The Measure
button is a tool for obtaining measurements from the view screen.
However, you may want to obtain more exact measurements of
developable land for these parcels.
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Begin by clicking the Intersect button. Choose Parcels as
the intersect theme and Undevelopable Land as the
overlay theme. Save the file as “intrsect.shp” and rename it “Intersection.”
This file contains polygons representing the undevelopable land for each
parcel.
You can use these undevelopable lands to find the total developable area
for each parcel. First, add a number field (named “Area”) to the Attribute
of Parcels table. Click the Calculate button, type the following in the
expression box: [Shape].ReturnArea and click OK. This will calculate
the area of the polygons in this shapefile. Now, repeat this procedure for
the Intersection table, adding a number field (named “Intersection Area”)
and calculating the area of these polygons.
Now, with Intersect as the source table and the Parcels as the destination
table, join the tables on the field “Parcels_id.” Add a number field to the
Attributes of Parcels called “Develop” and calculate this field equal to
Sum_Area minus Intersect Area. In other words, you are calculating the
amount of land in each parcel that does not fall into one of the setback
zones.
You can fill in the gaps in this analysis by including the 107 parcels which
have no overlap with the setbacks themes and therefore, have no values for
“Develop.” Build a query on your Attributes of Parcels table, selecting for
Develop values >= 0. Reverse this selection. Highlight the Develop field
name and calculate this field equal to Sum_Area. In other words, if there
is no overlap with a setback zone, a parcel’s total area is considered
developable.

Chart the amount of developable land on vacant, lakeshore parcels.
Once again, you are going to restrict your analysis to vacant parcels, with
no buildings, within 1000 feet of the Lake Michigan Shoreline. With the
Parcels theme active, use the Select by Theme... operation to select this
set.
One way to examine this data is to make a chart
illustrating the amount of developable land for each
shoreline parcel. Open the Parcels theme table. Click the Create Chart
button. From the Chart Properties Dialog Box, name your chart
“Developable Lands.” Select the field Develop and click the Add button.
Choose to label the series using Parcel_id. Click OK. Your chart will
now be displayed.
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You may wish to modify the default chart. Begin by
clicking the Chart Element Properties button to
allow chart editing. The following instructions highlight some of the chart
format options available.
Legend: Click anywhere on the legend to access the Chart Legend
Properties dialog box. By clicking at a location on the Legend Position
Diagram, you can move your legend to one of five location. Place the
legend below the chart.
Title: Click anywhere on the title to access the Chart Title Properties
dialog box. Change your title to “Amount of Developable Land Along the
Lake Michigan Shoreline.”
Axis: Under the Chart pull down menu, select Hide X Axis to hide the
group field name from view.
Remember, there is a direct link between your chart, your table and
your view. Changes in any of these documents will be reflected in the
other two! For example, if you change a Group Label in your chart,
your table will now display the field with this new label as an alias.

Color: Click the Chart Color button to access symbol palettes. From the
Color Palette, choose a new color for your title by clicking on the color
and then clicking on the title.
There are a number of other chart options available. For example, if
you wish to display your data as another type of chart (e.g. bar), simply
click the appropriate button on the button bar. A variety of additional
editing capabilities are available under Layout. Simply import your
chart into a layout using the Chart Frame tool. Now you can improve
your chart by adding text and changing fonts.

Bar Chart Gallery

Chart Frame

Close Chart Window.

Flag vacant, lakeshore parcels with minimal developable lands.
Although visual interpretation of maps and charts will give you an overall view of this
issue, you may want a more qualitative solution to help you with your decisions. In this
section, we will flag parcels will less than 25,000 available square feet for development
as “parcels for potential concern.” The 25,000 square feet value is somewhat arbitrary; it
is simply intended to represent a value for which siting a home may be more difficult.

7/17/2003

Coastal GIS Applications -- Town of Mosel (ArcView 3.x)

Page 35

These may be parcels where zoning administrators will pay extra attention when
evaluating any submitted permits. However, feel free to change this value if 25,000 does
not make sense to you.
The vacant, lakeshore parcels without buildings
should be highlighted. Create a query on this theme,
selecting from the current set any parcels with less than 25,000 feet of
developable land. Move these records to the top of the table using the
Promote button. Add a string field to the Parcels theme called “Flagged.”
Type “Yes” in this field for the 7 of 9 highlighted records. (If you look at
the map, you will find that two of these parcels are road right-of-ways -Parcel_id 99633411 and 99633442 -- and should not be flagged.)
The accuracy of these buffers in determining setback distance is only as good as the
accuracy of the lines on which they are based. Any user of these model applications
should be aware of the following data limitations and the assumptions made in this
analysis:
1. The Shoreland-Floodplain Ordinance requires a 75-foot setback from the ordinary
high water mark for all inland navigable waters. In this analysis, you made two
assumptions that could be challenged: (1) all inland waters are navigable, and (2)
the rivers and streams can be portrayed by one “centerline” (rather than their two
shorelines).
2. The Town of Mosel Zoning Ordinance requires a minimum setback of 80 feet from
road centerlines, with a 100-foot requirement for state and federal highways.
However, the digitized road segments do not differentiate between county, state,
federal or “unofficial” (e.g. military base) road segments. Your 80-foot buffer will be
inappropriate in some places.
3. As you know, the dynamic nature of the Lake Michigan shoreline makes it a difficult
feature to digitize accurately. The location of the ordinary high water mark, the basis
for this setback, is not static. Therefore, the setback cannot be static.
4. Without information describing the creation of this digitized shoreline, we cannot be
certain whether the digitized line represents the ordinary high water mark, the
location of the water’s edge at the time an aerial photograph was taken, or some
other feature that was interpreted as the “shoreline.” This type of background
information about a GIS data feature is called “metadata” and should always be
recorded when a GIS layer is created!
Save your project.
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permit

In this section, you will evaluate aerial photographs and permit information to identify
whether structures along the Lake Michigan shoreline are in compliance with the
shoreland permit regulations.

Evaluate aerial photographs to determine the age of structures.
Old aerial photographs of Sheboygan County are a good source for tracking the
development of this area over the last sixty years. From these photos, it is possible to
determine the approximate age of the structures along the shoreline. Of particular
importance to this application is the date October 27, 1970. Structures built prior to this
date are considered “non-conforming” uses if they do not meet current requirements of
the zoning districts. Structures built after the effective date of the ordinance that do not
meet the requirements of the ordinance and do not possess a proper variance or permit
may not be compliant. In these cases, further investigation may be warranted. Aerial
photos from the years 1941, 1961, 1967, 1971, 1978 and 1992 were used to determine the
age of major structures within 1000 feet of the Lake Michigan Shoreline. In the Shoreline
Structures theme, the field “When_built” contains the range of years when buildings first
appeared in the location of the point.
Copy the Shoreline Structures theme from the Shoreline Recession
Scenarios view into your Shoreland Zoning Ordinance view and make it
the active theme. Use the Select by Theme... operation to select all of the
shoreline structures that intersect with the Lake Michigan Setback theme.
To find out if any of these structures were constructed after the ordinance
went into effect, build the following query in the attribute table:
([When_built] = “1972 - 1978”) or ([When_built] = “1978 - 1992”). Click
Select from Set. Two points should be highlighted.
Now you will see if these two structures have shoreland permits. Add the
table “moselplg.dbf” to your project under the project window. Using
moselplg.dbf as the source table and Attributes of Shoreline Structures as
the destination table, join the tables on the Parcel_id field. You will note
that neither of the selected structures have permits. Therefore, further
review may be warranted to determine if they are in compliance with the
Ordinance. Save your project.
This application points out the difficulties in working with a changing feature like the
Lake Michigan Shoreline. If the shoreline was a farther distance away when these
buildings were constructed, they may have been in compliance with the ordinance at that
time. Using photogrammetric techniques, you could determine the distance of these
structures from the shoreline at the time the photos were taken.
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7.
Informing landowners about septic tank
regulations.
In this section, you will generate a form letter, asking landowners for information about
their septic systems.

Link attribute files containing information on parcels, sanitary systems
and land ownership.
Return to your Data Layers view.
Add the dBase file called
“moselsan.dbf” and “ownerwww.dbf” to your project. Both these attribute
files share the Parcel_id field in common with the Parcels theme. With the
ownerwww.txt file as the source table and the Attributes of Parcels as your
destination table, join these tables.
Perform a second join using the moselsan.dbf as the source table and the
Attributes of Parcels as the destination table. Once again, use Parcel_id as
the common field.
In order to make the Attributes of Parcels table less complicated, you
can hide some of the fields from view. From the Table Menu, choose
Properties, and uncheck any fields which you wish to hide. These
fields won’t appear if you print the table. In addition, they can’t be
used to label or query the theme.

Display developed parcels without sanitary permits.
Make the Parcels and Buildings themes visible. Display the Parcels theme
in gray, outlined by another color. Clear any selection you may have on
this theme.
You will now find all the parcels that are developed
(i.e. overlap with the Buildings theme). With the
Parcels theme active, under the Theme menu, choose Select by Theme....
Select the features of Buildings, and make sure Intersect is displayed in
the top box. Click New Set. Convert these features to a shapefile, save
the file as “developed.shp,” add the file to your view and rename it
“Developed Parcels.” Click the Clear Selected Features button for the
Parcels theme.
Make the Developed Parcels theme visible and active. In order to select
only the parcels without sanitary permits, we will first select those with
permits and then reverse the selection. In the attribute table, under the
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Table menu, choose Query. Build the following query: ([Sanpermit] >
0). Select New Set. Now click the Switch Selection button. All of the
parcels with buildings, but without recorded sanitary permits, will be
highlighted.

Mail merge ownership data with a form letter using Microsoft Word.
For this section, a form letter called “notify.doc” has been created. This letter is intended
to illustrate the capabilities of coupling the GIS and word processing functions. Feel free
to edit the letter and insert additional merge fields to make this exercise more relevant to
your applications.
First, you need to save your current selection as a dBase file. Make sure
your Attributes of Developed Parcels table is open. To export the database
file, from the File menu, choose Export. Highlight dBase and click OK.
Choose a directory and name to save your file (notify.dbf). Save your
project, minimize the ArcView screen and open Microsoft Word.
Open the file “notify.doc.” In the Tools menu, select Mail Merge. From
the Mail Merge Helper box, under Step 1 -- Main Document, choose form
letters from the Create drop-down menu. A question box will appear;
click Active Window.
Proceed to Step 2. Select Open Data Source under the Get Data dropdown menu. From the List of Files Type, choose the dBase(*.dbf) option.
Select “notify.dbf” and click OK. In the Confirm Data Source dialog box,
highlight your appropriate dBase connection and click OK. A question
box will appear stating that no merge fields have been identified; click the
Edit Main Document button. Place the cursor below the line “Sheboygan
County Property Owner.” From the Insert Merge Field scroll list, select
STREET. Move to the next line and add the merge field CITY. Now,
type a comma followed by a space and the letters “WI” and two spaces.
Add the merge field ZIP5.
To proceed with the final step, choose Mail Merge from the Tools menu.
Under Step 3, click Merge.... The Merge Box will appear; simply click
the Merge button and the program will produce 273 separate form letters
for all of the affected properties.
Save your project.
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Evaluation:
Coastal Erosion and Shoreland Development Regulation - Town of Mosel, WI
Please complete the following evaluation to help us better understand your experience
with this tutorial and to increase the effectiveness in future updates to the exercise.
How useful did you find this exercise?
□ Very Useful
□ Somewhat Useful
□ Not very Useful
How would you rank the difficulty of the exercise?
□ Too easy
□ Just the right level of difficulty
□ Very difficult
Were the instructions easy to follow?
□ I strongly agree
□ I agree
□ I disagree
□ I strongly disagree
□ Not sure
Did you feel the content was appropriate in understanding the GIS applications?
□ I strongly agree
□ I agree
□ I disagree
□ I strongly disagree
□ Not sure
Would you recommend this exercise to co-works, fellow students, etc?
□ Yes
□ No
□ Maybe
Please add any suggestions that you may have in assisting with the future development
and updates to this exercise.

Please mail this evaluation form to:
University of Wisconsin Sea Grant Institute - Attn: David Hart
Room 201, Goodnight Hall - 1975 Willow Drive - Madison, WI 53706-1177

